This guide relates to stages REC 6-8 of the recruitment process outlined in the Recruitment Statuses and Events diagram.

For further guidance on recruiting staff, please see the Personnel Service webpages.

This guide covers the following process steps:

A. **Review and Submit Web Applicants** ................................................................. 2
   1. Submit web applicants.................................................................................. 2
   2. Unsubmitting an application ...................................................................... 5
   3. Screen Applicants......................................................................................... 6
   4. Generate Applications................................................................................. 7
   5. Manage Attachments................................................................................... 10
   6. Generate Shortlist Form............................................................................. 12
   7. Run Private Questions Report...................................................................... 13

B. **Manage Interviews** ....................................................................................... 14
   8. Schedule Interviews.................................................................................... 14
   9. Changing Interview times .......................................................................... 17
  10. Generate interview invite letters................................................................. 18
  11. Generate Rejection Emails....................................................................... 21
  12. Manage Attachments to Emails................................................................. 23
  13. View Referees.............................................................................................. 24
  14. Edit Referee Details – manual applicants only.......................................... 25
  15. Add Referee Details.................................................................................... 26
  16. Request Online References....................................................................... 27

C. **Manage Offers and Manage Checks** ........................................................... 27
  17. Record Offer.................................................................................................. 27
  18. Record verbal offer...................................................................................... 27
  19. Record accepted offer................................................................................. 30
  20. Define Applicant Events............................................................................. 31
  21. Complete Applicant Events....................................................................... 31

D. **Close the Vacancy** ....................................................................................... 32
  22. Ensure pre-requisites have been met: ....................................................... 32
  23. For vacancies requiring Work Permit: ...................................................... 32
  24. Enter Closing Date and Final Status: ....................................................... 33
A. Review and Submit Web Applicants

This will allow you to review and import all web applications.

1. Submit web applicants

1.1. The Submit Web Applicants form will open. Enter your search criteria and click the Search button. To search by vacancy ID follow the steps below:

1.2. Click on Query Mode.

1.3. Enter the Vacancy ID in the lower half of the screen.

1.4. Click on the green tick to run the search.
If your search does not return any results this could be because there are currently no applicants waiting to be submitted. To check if any applicants have already been submitted go to Vacancy Detail and search for your vacancy. The number of applicants submitted will be shown after the Job Title in the Description field (see below). If there is no number displayed then applicants have not been submitted. Alternatively check the vacancy in the Applicant Status screen.

1.5. The search will return any vacancy(ies) that meet the search criteria entered. The number of applicants and whether they were on-line or manual will be displayed. Double click on the vacancy number to open the Applicant Acceptance screen.

1.6. The Applicant Acceptance screen will open and display the list of applicants who have submitted an application.
1.7. The system will have given each applicant a unique applicant number which will be displayed in the first column.

**Note:** Please ignore the colour coding and score data as we are not using this functionality.

**Note:** To view individual applications, click on the Details button on the far right of the screen. The application will open in a new window in your browser.

1.8. Select the applications to be submitted by clicking on the tick box to the right of the relevant applications (or click the **Select All** button).

1.9. Click the **Update** button. This will import the applicants into Core. The *applicant status* window will appear:

1.10. The date and applicant status will auto populate and should not be changed. (The only exception is where you have an applicant who has applied late in which case you can change the applicant status to pull through their application.) For further details refer to the ’Recruitment Statuses and Events’ documents.

1.11. Click the **Update** button. This will import the applicants into Core.

1.12. A confirmation message will appear, click **OK**. The selected applications will no longer be shown in the applicant acceptance screen. Their status will show as *Applied* against the vacancy in the Core back office.

1.13. To open the Applicant Status screen click on the Applicant Status button:
Note: If you open the Applicant Status screen from here you cannot then navigate to the vacancy. You will need to red door back to Recruitment Maintenance > Vacancy Details to open the vacancy.

1.14. Alternatively click the button to exit.

Note: Do not click on the Select Unsuitable Applicants button as we are not using this function.

2. Unsubmitting an application

If an applicant has asked you to unsubmit an application (possibly to make a change or addition), and it is before the closing deadline, click the Unsubmit button, enter a reason and SAVE.
The applicant will receive an email to confirm their application has been unsubmitted. If at any point you are unsure about unsubmitting an applicant, contact the HRIS Support Centre.

3. **Screen Applicants**

If you clicked on the Applicant Status button from the submit web applicants screen go straight to step 3.2., otherwise:

![CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Status](image)

3.1. The Search Criteria form will open. Enter your selection criteria (normally the **Vacancy Id** and **Applicant Status** e.g. **Applied**) and click the **Search** button.

3.2. The applicants that match the search criteria will be displayed.

3.3. To view an applicant's application, click once in the relevant row and click the **Application Detail** button. The application will display in a new window.

After the vacancy closing date you are required to review each application to identify any priority candidates and check that a letter of redeployment has been attached (or e-mailed to you if you have used the application form with inbuilt statement). Where the redeployment letter has been provided, you should add ‘Priority Candidate’ into the Comments field against the relevant applicant(s). Any priority applications will be included in the merged application pack that is sent to the selection panel for consideration. (Remember to attach the letter where this has been e-mailed to you – see **section 5.4** for guidance). However, if preferred by the selection panel, priority applications can be considered before the vacancy closing date.
3.4. To view the applications of all applicants (including attachments such as redeployment letter), click on the Applicant Detail Report button. The applications will display in a new window.

4. **Generate Applications**

The application submitted by each applicant is made up of a number of parts. There are the web forms completed by the applicant online, such as Referee Details and the Questionnaire and there are attachments, such as Supporting Statements and CVs. Whilst the online parts of the application form one document, each applicant can submit up to 5 additional attachments, with each of these being held as a separate document (the only exception is where the application form with inbuilt supporting statement has been used, as this does not permit applicants to attach documents).

The Generate Applications process combines these separate documents into a single PDF file per applicant.

---

CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Status

4.1. The Search Criteria form will open. Enter your selection criteria (normally the Vacancy Id and Applicant Status e.g. Applied) and click the Search button.

4.2. The applicants that match the search criteria will be displayed.

4.3. Click the Generate Applications button. The Generate Applications screen will appear.
4.4. Select all applicants for whom you wish to generate a PDF file by clicking the tick box to their right (or click the [Select All] button).

4.5. Click the [Generate Applications] button.

4.6. A pop-up message will appear

4.7. Click on the [OK] button. The pop-up window and the Generate Applications screen will close. As per the pop-up message, you will now receive an email to the email account linked to your personnel record once the job has been completed.

4.8. Once you have received the email to confirm that your applications have been generated, return to the Applicant Status screen and click on the [Generate Applications] button.

The Generate Applications screen will appear and you will see a link to the right of each applicant. This link shows the date and time the PDF was created. You can click on this link to open and view the PDF file.

You should also review the error column as this will indicate if any of the applications did not generate successfully. If anything is displayed in the error column contact the HRIS support centre for assistance on hr.systems@admin.ox.ac.uk
4.9. To merge the individual PDF files into a single PDF pack for distribution to the interview panel, proceed as follows:

4.10. Select the relevant applicants by clicking the tick box to the right of each applicant (or click the **Select All** button).

4.11. Click the **Merge Applications** button.

**Note:** For vacancies that contain more than 150 applicants, or contain large attachments against individual applicants, we recommend breaking up the merging of applications into smaller packs to avoid issues with this process.

4.12. You will see a pop-up message confirming that your request has been submitted and you will be sent an email when the job has been completed.

4.13. Once you have received the email, return to the Generate Applications screen and open the merged application pack by clicking on the date/time stamp link in the bottom right corner of the screen.

4.14. Select **Save As** from the **File** menu to save the PDF pack to a secure location.

The following file sharing options are recommended by IT Services:

1. Local shared drive managed by your IT Department
2. SharePoint
3. Encrypt the data before e-mailing and then share the password securely (i.e. NOT via e-mail)
4. An encrypted USB stick (available from the IT Services shop)

The latest advice on sharing confidential documents by email and alternative solutions can be found on the University’s Information Security website [here](#).
To add an additional late application to the merged file, select **Delete Merged Application** and click **OK** to the warning message. Create a new merged file following the instructions in **section 1.3**, but at step 4 select only the late applicant to generate their merged application. Then click on **merge applications** to create a new merged pack to include all applicants.

**Note:** You will also need to create a new merged PDF before closing vacancies requiring a Work Permit in order to keep a final record of all shortlisted applications. See **section D. Close the Vacancy** for further detail.

5. **Manage Attachments**

To view, add or ignore documents attached to the application by an online applicant:

**CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Status**

5.1 **To view a document**

5.1.1. The **Search Criteria** form will open. Enter your selection criteria (normally the Vacancy Id and Applicant Status e.g. Applied) and click the **Search** button.

5.1.2. Click once to highlight the row for the relevant applicant.

5.1.3. Click the **Applicant Detail** button.

5.1.4. Select **Vacancy Detail** in the **Select Detail** area.

5.1.5. Click once to highlight the row for the relevant vacancy.

5.1.6. Right click over the highlighted row.

5.1.7. Select **View Documents** from the shortcut menu. You will be taken to the **Document Details** tab.

5.2 **To Open a Document**

5.2.1. Click on the file name. The document will open in a new window.
5.3 To Exclude a Document from the Selection Panel PDF File

5.3.1. Click to place a tick in the **Ignore** column against the relevant attachment.

5.3.2. Click the button.

5.4 To Attach an Additional Document

**Note:** All documents manually attached to an application will be visible to the applicant through the applicant portal. This approach is therefore not suitable for confidential documents you do not wish to share with applicants, such as references.

5.4.1. If the additional document has been emailed to you by the applicant, save it to a secure network location.

5.4.2. Click the **Load Document** button. A new window will open.

5.4.3. Click the **Browse...** button.

5.4.4. Click the **Open** button.

5.4.5. Browse to select the relevant document.

5.4.6. Click the **Upload** button.

5.4.7. Once the upload has been successful click the **Close window** button to return to Core.

5.4.8. Click **Yes** to confirm the upload was successful.

5.4.9. Click the button.

If you had already generated the PDF’s for the shortlisting panel you will need to re-generate them at this point to exclude the incorrect attachment and/or include the new one.
6. **Generate Shortlist Form**

Use this option to generate the shortlist form for the Interview panel to complete.

CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Status

6.1. The *Vacancy* screen will open. In the *Vacancy Id* field, select your vacancy from the list of values.

6.2. Select the relevant *Applicant Status* from the drop down e.g. *Applied*.

6.3. Click the **Search** button. A list of relevant applicants will be displayed.

6.4. Select **Tools > Letters** from the menu.

6.5. The *Generate Letters Module* dialogue box will appear:

6.6. Select Letter Group: Recruitment

6.7. Select the *Letter Type* A Shortlist Form Standard or B Shortlist Form Extended.

6.8. Options will default to ‘Perform Mail Merge’ and must not be changed

6.9. Ensure the *Selection* option is set to *All Query Records*.

6.10. Click the **OK** button.
6.11. Choose ‘Open’ for prompts to appear

6.12. If you can’t see the prompt questions, minimise all screens to find prompt box

6.13. If the message below appears at the top of the page click on Enable Content

![Security Warning](image)

6.14. The shortlisting document should now contain the applicant information.

6.15. In the new document enter the selection criteria from the job description under the ‘Essential’ and ‘Desirable’ column headings.

6.16. Save and distribute the form as required (see note on secure file sharing section 4.4 above).

6.17. Close Word and return to Core.

If you have any priority candidates it is important to indicate these against their entry on the form.

At this stage you should change the status of the vacancy to Shortlisting.

Once shortlisting has been completed and the panel has reported back with their decisions you should change the status of the relevant applicants to Shortlisted or Rejected after Shortlisting.

See QRG: REC00_Recruitment Basics for further details on updating statuses.

7. **Run Private Questions Report**

To review the answers to questions about interview availability, disciplinary matters, criminal convictions and University connections you will need to run the RECDEP47_Private Questions report in Discoverer.
Note: These questions do not appear in the merged PDF application file that you generate and send to the interview panel.

7.1. Where invalid applications are found, change the applicant status by clicking the Status drop-down and selecting Invalid. Enter the reason into the Comments field. You will need to notify any affected applicants off system.

7.2. Click the button.

At this stage after running the Private Questions report you should update the vacancy events checklist eg Right to Return checked.

B. Manage Interviews

This section of the guide relates to the recruitment process outlined on the Personnel Services website. Go to Personnel Services>Recruiting staff.

8. Schedule Interviews

CorePersonnel >Recruitment >Recruitment Maintenance >Vacancy Detail

8.1. The Search Criteria form will open. Enter your search criteria and click the Search button.

8.2. Double click the relevant vacancy to open it.

8.3. From the Select Detail area, select Applicant Status.

8.4. The Applicant Status Maintenance screen will be displayed showing the list of applicants.

8.5. To show only those applicants you wish to invite to interview, select the relevant status (e.g. Shortlisted) from the Applicant Status drop-down in the search area at the top of the screen. Click the Search button.

8.6. Select the Schedules tab.
8.7. Click the **Add Schedule** button. The *Add/Edit Schedule* screen will be displayed.

### Field Name (* mandatory) | Description
--- | ---
**Schedule Type** | Select as appropriate (e.g. Interview).
**Round** | Select the Round (and Schedule Number if required).
**Title** | Enter a Title e.g. Interviews for [job title].
**Assign type** | Select individual or group. Individual = one person being interviewed at a time Group = group assessment
**Applicant status** | Select as appropriate (e.g. Shortlisted).
**Venue** | Enter the name and details of the venue. Ideally you should enter the full address so that it can be merged into the interview invite letter/email.
**Start Date** | Enter the interview date in the format **dd-mmm-yyyy**.
**Start Time** | Enter the time of the first interview (e.g. 9:00)
### End Time*
- Enter the time you expect the last interview to finish (e.g. 17:00)

### Duration*
- Enter the length of each interview in minutes

### Lead Time
- Enter the time required between each interview in minutes e.g. 15 minutes

### Breaks
- Enter the time and duration of any breaks and lunch if appropriate in minutes.

---

#### 8.8.
Click **Save** then **OK**.

#### 8.9.
Click the **Assign Schedule** button. The *Assign Applicant/Interviewer* screen will be displayed.

#### 8.10.
To select the applicants you wish to invite for interview, click in the tick box/es at the end of their row or filter on Applicant Status (shortlisted) and click the **Select All** button.

#### 8.11.
Click the **Assign Interview Times** button. A time will be entered into the schedule time column for each interviewee selected.

#### 8.12.
Click the **Save** button. A confirmation message will appear, click **OK**.

#### 8.13.
From the same screen select the **Interviewers** tab.

#### 8.14.
Select the interviewers you wish to use by selecting the tick box to the right of their row, (or click the **Select All** button).
In order to do this you must first have recorded who the interviewers are. See the section entitled 'Add / Maintain Interview Panel' in QRG: REC01_Creating a Vacancy for further details.

8.15. Click the then .

8.16. Select the Applicant Schedules tab to see the scheduled date and time for each applicant.

8.17. Select the Interview Schedules tab to see the scheduled date and time for each interviewer.

9. **Changing Interview times**

Follow these steps to change the day and/or time for any of your applicants after creating the schedule, eg if your first candidate has a long journey.

9.1. Navigate to the Applicants Schedule tab

9.2. Override the time or select a new date for your applicant
9.3. Click **Save** then **OK**.

9.4. Navigate to the **Schedules** tab.

9.5. Click **Assign Schedule**.

9.6. The Applicants tab will open showing the changes you have made.

9.7. Click **Save** and **OK** the message then **Cancel** to close.

10. **Generate interview invite letters**

For an example of how to send email correspondence, follow the steps in **section 10 Generate Rejection Emails**.

10.1 The **Vacancy** screen will open. In the **Vacancy Id** field, select your vacancy from the list of values.

10.2 Select the relevant applicant status e.g. **Shortlisted**.

10.3 Click the **Search** button. A list of relevant applicants will be displayed.
10.4 Select **Tools > Letters** from the menu.

10.5 The *Generate Letters Module* dialogue box will appear:

Update as follows:

10.1.1 Letter **Group**: Recruitment (default)

10.1.2 Select the Letter Type Invite to Interview

10.1.3 Options will default to ‘Perform Mail Merge’ and must not be changed

10.1.4 Ensure the Selection option is set to All Query Records.

10.1.5 Ensure the Send Email field is unchecked.

10.1.6 Click the **OK** button.

10.1.7 A new pop up window will open.
10.6 Choose ‘Open’ for prompts to appear

10.7 If you can’t see the prompt questions, minimise all screens to find prompt box

10.8 If the message below appears at the top of the page click on Enable Content.

Note: The message will also appear if you re-open the document. Either click on ‘Enable Content’ or the ‘x’ on the right-hand side which will ensure that the macro will not re-run as it has now been disabled.

If you receive the message below, select ‘No’.

10.9 Enter the relevant details for each prompt. NB: some prompts are repeated for each applicant. You will need to answer each of these in turn for each applicant you are generating a letter for.

10.10 If required amend the text.

10.11 Save, print and post the letter as required.

10.12 Save the document in a secure location as a .doc or .docx file and Exit to return to CoreHR.
10.13 Close the window in your browser.

10.14 If the document is saved as a .docx you will not see the above Security Warning when reopening a saved document.

10.15 Click Yes to the confirmation message. This will generate a record in the letter history screen.

Once all the interview invitations have been sent you should change the status of the vacancy to Interview and the applicant status of invited applicants to Invited to Interview 1 (see QRG: REC00_Recruitment Basics for further details).

N.B. If you are holding a second round of interviews, once the invitations have been sent for round 2, change the applicant status of these applicants to Invited to Interview 2.

11. **Generate Rejection Emails**

This example uses the Core email functionality to generate correspondence. For an example of how to send correspondence as a Word document please see section 9 above.

CorePersonnel > Recruitment > Recruitment Maintenance > Applicant Status

11.1 The Vacancy screen will open. In the Vacancy Id field, select your vacancy from the list of values.

11.2 Select the relevant applicant status e.g. Rejected at Shortlisting or Rejected at Interview

11.3 Click the Search button. A list of relevant applicants will be displayed.

11.4 Select Tools > Letters from the menu.

11.5 The Generate Letters Module dialogue box will appear:
11.5.1 Letter Group: Recruitment (default)

11.5.2 Select the *Letter Type* Email reject after shortlist feedback/no feedback as applicable.

11.5.3 Options will default to ‘Perform Mail Merge’ and must not be changed

11.5.4 Ensure the *Selection* option is set to All Query Records.

11.5.5 Ensure the *Send Email* field is checked.

11.5.6 Click the **OK** button. The *send email window* opens:
11.5.7 Enter the email address shown in the From field to the email address you wish people to reply to.

11.5.8 Click the Apply to All button to apply the new email address to all emails in this batch.

11.5.9 Whilst this should not be required for rejection emails, you can amend the content of the email if necessary.

If you have selected multiple recipients for the email, and wish to amend the email text, you will need to edit each one in turn. Navigate through the list of recipients by using the Next>> button.

12. Manage Attachments to Emails

If you wish to add an attachment to the email/s, follow section 10 above then:

12.1 Click the Attachments button.

12.2 Click the Browse button.

12.3 Browse to the document you wish to attach and click it once to select it.

12.4 Click the Open button.

12.5 To add further attachments, click into the next row down and repeat steps 13 – 15 above.

12.6 Click the Save button.

12.7 A confirmation message will display, click the OK button.

12.8 Click the Close button.

12.9 To add the same attachment to all emails, click the Apply to All button.
12.10 Click the **Send All** button. A confirmation message will appear, click **OK**.

**Note:** If you use the email type ‘GENERIC EMAIL TEMPLATE’ you **must** add an attachment for all recipients of that email.

The system can be used to administer different rounds of recruitment selection by repeating the steps outlined in sections 9 to 11 and selecting appropriately.

You should be careful to ensure the correct Vacancy and Applicant statuses have been applied at each stage. Please see QRG: REC00_Recruitment Basics for further details of the uses of this information.

13. **View Referees**

It will be possible to view the referee details once an applicant has made an application for a vacancy.

CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Status

13.1 The **Search Criteria** form will open. Enter your selection criteria (normally the Applicant No., click the **Search** button and select the applicant from the list provided) and click the **Search** button.

13.2 Click once to highlight the row for the relevant applicant.

13.3 Double click on the highlighted row to open the Applicant Maintenance screen.

13.4 Select **Vacancy Detail** in the **Select Detail** area.

13.5 Click once to highlight the row for the relevant vacancy.

13.6 Right click over the highlighted row.

13.7 Select **View References** from the shortcut menu. You will be taken to the **Reference Details** tab.

13.8 To view the full details of a referee, click the **Details** button.

13.9 To close the referee details, click the **Cancel** button.
13.10 To exit the referee details screen, click the button.

Where applicant details have been added via the manual route, the referee details can be edited and added to. If the applicant has applied online, the referee details can only be viewed.

Note: All documents manually attached to an application will be visible to the applicant through the applicant portal. This approach is therefore not suitable for confidential documents you do not wish to share with applicants, such as references.

14. **Edit Referee Details – manual applicants only**

Referee details may have changed since the time of application. Use this section to amend the referee details for any applications which have been entered via the manual application route.

| CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Details |

14.1 The Search Criteria form will open. Enter your selection criteria (normally the Applicant No., click on the button and select the applicant from the list provided) and click the button.

14.2 Click once to highlight the row for the relevant applicant.

14.3 Double click on the highlighted row to open the Applicant Maintenance screen.

14.4 Select Vacancy Detail in the Select Detail area.

14.5 Click once to highlight the row for the relevant vacancy.

14.6 Right click over the highlighted row.

14.7 Select View References from the shortcut menu. You will be taken to the Reference Details tab.

14.8 To access the full details of a referee, click the button.

14.9 Make the required changes.
14.10 Click the [Save] button.

14.11 To exit the referee details screen, click the [ ] button.

15. **Add Referee Details**

The applicant may be required to supply further referee details. Use this section to add details of further referees.

**CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Details**

15.1 The Search Criteria form will open. Enter your selection criteria (normally the Applicant No., click on the [ ] button and select the applicant from the list provided) and click the [Search] button.

15.2 Click once to highlight the row for the relevant applicant.

15.3 Double click on the highlighted row to open the Applicant Maintenance screen.

15.4 Select **Vacancy Detail** in the **Select Detail** area.

15.5 Click once to highlight the row for the relevant vacancy.

15.6 Right click over the highlighted row.

15.7 Select **View References** from the shortcut menu. You will be taken to the **Reference Details** tab.

15.8 To add a new referee, click the [Add Reference Details] button.

15.9 Complete the fields as required.

15.10 Click the [Save] button.

15.11 To exit the referee details screen, click the [ ] button.
16. **Request Online References**

This section has been temporarily removed as the functionality is not working as expected. When a referee attempts to submit a completed on-line reference form they receive an error message stating that not all mandatory questions have been answered. This issue has been raised with Core for further investigation and we will provide relevant updates via the monthly bulletin.

C. **Manage Offers and Manage Checks**

This section of the guide relates to the recruitment process outlined on the Personnel Services website. Go to Personnel Services>Recruiting staff.

Having made a verbal offer to your preferred candidate the checks linked to the applicant will need to be initiated off-system and then logged.

At this stage you should:
1. Change the status of the vacancy to **OFFER MADE**.
2. Update the applicant events checklist when checks are initiated.
3. Change the status of the applicant to **Offer Made – Personnel**

**Note:** The updating of these statuses at each stage is imperative for equal opportunities monitoring and reporting. See QRG: REC00_Recruitment Basics for further details on updating statuses.

17. **Record Offer**

**CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Status**

If your preferred candidate applied via e-recruitment, having made a verbal offer to them the details should be captured in the Recruitment module – follow the steps in section 17.

When the candidate accepts the offer, the details should be updated against the relevant vacancy before the vacancy is closed – follow the steps in section 18.

**Note:** ‘Recruitment Administrator’ access is required for this action. Both sections must be completed.

**CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Status**

18. **Record verbal offer**
18.1 Enter the vacancy number into the **Vacancy ID** field and click **Search**.

18.2 Update the status of the preferred candidate to **Offer Made – Personnel**.

18.3 A message will be displayed ‘Do you wish to record offer details?’ click the **Yes** button.

In the Appointment Offer screen:

18.4 Select the **Post Number [A]** using the LoV icon then press the **[Tab]** key.
18.5 Select the post number sequence [B] using the LoV icon then press the [Tab] key.

**Note:** If the post number or post number sequence you are expecting is not in the LoV list then contact HRIS Support.

18.6 Enter/change any details relevant to the offer details:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effective date</td>
<td>Expected start date.</td>
</tr>
<tr>
<td>Job Text</td>
<td>This is the actual job title that will appear in the template documents, such as the conditional offer/contract letter.</td>
</tr>
<tr>
<td>Employee status</td>
<td>E.g. Permanent, Fixed term.</td>
</tr>
<tr>
<td>Sub Status</td>
<td>E.g. Full time, Part time.</td>
</tr>
<tr>
<td>Hours</td>
<td>Expected working hours per week, as agreed with the individual.</td>
</tr>
<tr>
<td>FTE Hours</td>
<td>Standard FTE hours for this role (depends on grade).</td>
</tr>
<tr>
<td>Weeks (term-time employees only)</td>
<td>Enter the number of weeks the employee works per year inclusive of holiday entitlement. E.g. if the employee works 38 weeks per year and is entitled to 4 weeks holiday, enter 42 weeks. NB: only applicable to term time employees who are paid the same amount each month.</td>
</tr>
<tr>
<td>FTE Weeks</td>
<td>This field will be set by the system to 52.</td>
</tr>
<tr>
<td>Comments</td>
<td>Record anything of interest about the offer made.</td>
</tr>
</tbody>
</table>

**Note:** If preferred, this information can be left for now and completed at appointment stage.

18.7 Click the **Next >>** button:
18.8 If required change/check any details relevant to the pay details:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
<td>Scale point</td>
</tr>
<tr>
<td>Multiplier</td>
<td>Ensure this matches the FTE</td>
</tr>
</tbody>
</table>

18.9 Click the [Save] button, then click the [OK] button. The Applicant status window is re-displayed.

19. **Record accepted offer**

When the verbal offer has been accepted, the details must be captured in the recruitment module in order that they can be pulled through to personnel even where the offer details have not changed.

Follow steps 1-9 above but remember to update the status of the preferred candidate to Offer Accepted – Personnel.
Having recorded the accepted offer you can now generate documents to send to the new starter. See appendix below for a full list of documents that are available in the recruitment module.

20. **Define Applicant Events**

Having completed the interview exercise the selection panel will hopefully have selected a preferred candidate. Depending on the candidate and the post, specific checks will be required.

### CorePersonnel >Recruitment >Recruitment Maintenance >Vacancy Detail

20.1 If necessary, search for and open the relevant vacancy.

20.2 Select **Events** from the **Select Details** area. The events tabs will be displayed.

20.3 Select the **Applicant Events** tab.

20.4 For each check that is required for the preferred candidate place tick in the checkbox to the right of the item.

20.5 Click the **Cascade Events To Applicants** button. A confirmation message will appear, click **OK**.

21. **Complete Applicant Events**

### CorePersonnel >Recruitment >Recruitment Maintenance > Applicant Detail

21.1 Search for and open the relevant applicant record.

21.2 Select **Events** from the **Select Details** area. The event tab will be displayed.

21.3 As each required event is initiated, click in the **Checklist** field to add a tick. The completion of each required event will be recorded within CoreHR personnel. (See QRG: PANS0_Pre Arrival and New Starter Guide for further details).

21.4 Click the **button.
Ensure you also update the Vacancy Events screen to mark all the relevant Equal Opportunities monitoring events.

**D. Close the Vacancy**

![CorePersonnel >Recruitment >Recruitment Maintenance >Vacancy Detail](image)

These steps must be completed once the vacancy has been filled, or if it needs to be closed for any other reason.

22. **Ensure pre-requisites have been met:**

- The Applicant and Vacancy Events **MUST** be completed with all information relevant to the vacancy. This forms part of the review of recruitment procedures and practices and ensures the 'Code of Practice on Staff Recruitment and Selection' is operating effectively.

- The Applicant and Vacancy Statuses **MUST** be updated to reflect the latest/final statuses. Where the vacancy is being closed due to a direct appointment, use the vacancy status ‘Appointment Made’. Further information can be found in the Statuses and Events guidance which can be found on the Personnel Services website under Recruiting staff/Recruitment Process/Vacancy set-up and advertising.

23. **For vacancies requiring Work Permit:**

For vacancies requiring a work permit, UKBA (the UK Border Agency) requires you to keep a copy of all applications, in their original format, relating to all applicants who were shortlisted for that vacancy.

The following steps have been confirmed to meet this requirement:

![CorePersonnel >Recruitment >Recruitment Maintenance >Applicant Status](image)

23.1 Repeat the steps in section 4 Generate Applications to open the 'Generate Applications' window for the vacancy.

23.2 Click ![Delete Merged Application](image). This will remove the date and time link in the bottom right hand corner of the Generate Applications window and will therefore remove the full PDF application pack initially created for the Selection Panel.
23.3 Still within the same window, put a tick in the checkbox next to each candidate shortlisted for interview.

23.4 Click the [Merge Applications] button. The system will merge the selected applicants into a combined PDF file of just the shortlisted applicants. Once complete, a link will appear to the right of the button showing the date and time the PDF was created. The file should open automatically.

23.5 If necessary, click the date and time link to open the PDF. Select [Save As] from the [File] menu to save this file to a secure location for reference in relation to UKBA queries.

24. **Enter Closing Date and Final Status:**

**CorePersonnel >Recruitment >Recruitment Maintenance >Vacancy Detail**

24.1 The [Search Criteria] form will open. Enter your selection criteria and click the [Search] button. The [Vacancy Detail] screen will be displayed.

24.1.1. Select the appropriate vacancy status e.g. *Appointment Made* or *No Appointment Made* (a).

24.1.2. Enter a date into the [Date Closed] field (b).

24.1.3. Select the [Closed] radial in the [Vacancy Status/Date] section of the screen. Do not use the ‘Filled’ or ‘Hold’ radial (c).

24.2 Click the [button].
If your recruitment exercise was not successful and/or for all other scenarios please refer to QRG: REC04_Managing Vacancies and Appointments.

**Useful Reports:**
- RECDEP47_Private Questions

To review applicants for recruitment monitoring purposes don’t forget to regularly run RECDEP41_Applicant and Vacancy Details.